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I Road Network

4,70,000 kms Major 1,28,000 kms
District Roads State Highways  Including 200 kms Expressways

Population > 1 billion people
Road Network (2"@in world) - 3.3 million km

66,590 kms National Highways

2,650,000 kms Village & Other Roads

Roads carry 85% passenger and 70% freight traffic
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Vehicle Populatlon

Total Vehicle Population 73 million
(About 1% share of World)

13 % Cars & Jeeps

5% Goods Vehicles

2% Buses

10% others

70% Two Wheelers

23e Congres mondial de la Route -




=
i Vehicles Vs Road Lengths
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Accidents - 0.44 million (annual)
(7 every minute)

Injuries - 0.4 million (annual)
Fatalities > 95,000 (annual)
- 260 (daily)

- 1 (every 6 minute)

(Source —Road Accidents in India, 2005, MOSRTH India) . ) )
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Global

Fatalities/yr 1.2 million

Accident
Cost

US$400Db
(Euro 350 b)

Asia & India
Pacific
450,000 95,000

(~8% of Global)

US$100b US$18D
(Euro 90 b) (Euro 15b)
(Rs. 800 billion)
(~ 3% of GDP)
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Safety in Comparison (contd.)

Fatalities /10,000 Vehicles

UK 1.60
Japanl1l.74
Australia 1.84
New Zealand 3.29
Philippines 5.33
Iran 8.12

Thailand 11.16
Vietnam 14.42
Sri Lanka 15.53
Pakistan 18.69
India 25.27

China 26.20
Kazakhstan 36.50
Nepal 62.73
Bangladesh85.58
Tajikistan 107.00

0.00 20.00 40.00 60.00 80.00 100.00 120.00

(Source- Road Safety Guidelines For Asia & Pacific Region,1996, ADB)
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Fatalities in
Thousands

——>

Fatalities per gue=-m
10,000 Vehicles

8 23e Congres mondial de la Route - Paris 2007



Vehicles Involved in Fatalities

[0 Trucks/Buses and Other Heavy Vehicles (37%)
W Cars/Jeeps (19%)

B2 Wheelers (15%)

[ 3 Wheelers (4%)

Bl Others (15%)

B Non-motorized (8%)

9(Source —Road Accidents in India, 2005, MOSRTH India) 554 Congrés mondial de la Route -




= Accidents and Road Length as per

Road Classification

100%
90%
46.8
80% /
60%
/ O Other Roads

50% - B SH

{236 O NH
40% -
30% -
20%

29.6 2 4.1
10%
0% —

No. of Accidents Road Length\EE

(Source —Road Accidents in India, 2005, MOSRTH India)
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Accidents Causative Factors in India

16.15 %

1.24 %
1.76 %
1.30 %
™[79.55 %
B Driver's fault B Pedestrian fault

B Mechanical defect in vehicles l Bad roads
[ Other factors

(Source —Road Accidents in India, 2005, MOSRTH India)
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= Fatalities in Various Modes a Proportion of Total

. Fatalities
80 -
70 -
60 - [ Pedestrians
50 - —
_ B Bicyclists
40 —
30 -+ B Motorized
| |
20 wheelers
I I — _ 1 Motorized
10 I n I four
I I wheelers
0

India  Thailand Indonesia SrilLanka Malaysia Japan USA

(Source- Word Bank Report)
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= Major Problems

i 11 HRET .

“ Mixed Traffic _
» Fast Moving Bt
» Slow Moving

“* Preponderance of old /
poorly maintained Goods
vehicles

. s --J..-:-.f"' RS P S
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% User Attitude
»Public apathy

»Poor respect for
traffic rules

»>Low level of
awareness

»Lack of driving
culture
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Main Constraints

“*Inadequate Enforcement due to Lack of
» Awareness / Skill
» Tools
» Training

“*Lack of Safety Consciousness in policy
makers/ professionals

“*Infrastructural Deficiencies for Safer Travel
*Absence of Database and Analysis
*Improper Driver Licensing System
*Ineffective Institutional System

*Lack of Funds
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“~ Institutional Arrangements for Road Safety

Government of India
Ministry of Shipping, Road Transport and Highways

A

National Road Safety. Council Transport Development Council
A 4
¢ I I Jv_
Financial Transport | < Roads Transport Research
Wing Wing Wing Wing
A

eNational Highways

A
! eSecretariat for National ! Measures —>| NHAI
Road Safety Council | eResearch
eEducational Measures L, IRC e,
: *NGO’s Participation
i ! NITHE !
| . S |
| | A
e Research, Education and Technical Inputs -_::::::::-_:f________j
Y
| | | |
CRRI NGO’s Teaching Institutions State Research
Institutions
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“ |nstitutions Engaged in Road Safety

Functions
Agency Policy | Planning | Accident | Engineering Traffic Education, Research &
analysis measures regulation awareness, | development
and and training

standards enforcement

Central Government

Department of Road / / / / /

Transport &
Highways

Central Road
Research Institute, / / / ‘/

New Delhi

Central Institute of V4 V4
Road Transport, Pune

National Institute for
Training of Highway /
Engineers (NITHE)
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= s :
= Institutions Engaged in Road Safety
(Contd.)

Functions
Policy | Planning | Accident | Engineering Traffic Education, Research &
analysis measures regulation | awareness, | development
Agency and and training

standards enforcement

State Government

State Public Works

Departments
v/ 4 4
Police
Establishments / / /
State level
Research

Institutes/ Labs / / /
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= s :
= Institutions Engaged in Road Safety
(Contd.)

Functions
Policy | Planning | Accident | Engineering Traffic Education Research &
analysis measures regulation awareness development
Ag ency and and training

standards enforcement

Indian Roads

Congress
v/ v/

Academic
Institutions
including llITs

NGO’s

4 v/ o/
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* Drafting Road Safety Policy

*» Infrastructure Improvements

*» Creation of Road Safety Boards at Centre and States
s Safety Audit for New Projects

*» Ambulances and Highway Patrolling

** Enhanced fines for Traffic Rules Violations

** Manuals for Standards for 4 and 6 Lanes Highways
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Road Safety Policy

1994 Policy
» Reduction up to 50%0 by 2001 in fatalities and accident
» Improvement in Road Users behavior

*» Policy proposed now
» Commitment for significant reduction in accidents

> Eleven focus areas identified for achievement

Creation of data base

Safer Road Infrastructure
Safety of vulnerable road users
Safety education and training
Emergency Medical Services

Enabling legal, institutional and financial environment I
HRD and Research I
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= Infrastructure Improvements

“* National Highways Development Project (NHDP)

» 4-laning of 26,000 km (40%) of NHs in Phases I, 11 & 111
» 6-laning, Expressways, Ring roads, Bypasses etc
» Investment of about US$ 57 billion in next 7 years

“* Prime Minister’s Rural Development Project
» Access through all weather roads for
= Habitation with 500, in plains
= Habitation with 250, in hills
» Investment of about US$ 29 billion in next 7 years

+» National Urban Renewal Mission

» Infrastructure improvement for rejuvenation of Indian cities
» Investment of about US$ 11 billion in next 7 years
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= National Highways Development Project

(NHDP)

Estimated Cost

NHDP PHASES In

Rs. Billion | US$ Billion

Phase I : Balance Work (Gold’n Quadri’l) 88.11 2.15
Phase Il : Balance Work (NS-EW Corridor and 436.23 10.64
Others)

Phase 111 : 4-laning of 12,109 km on BOT 806.26 19.66

Phase IV : 2-laning with paved shoulder, of
20,000 kmon BOT- TollZ/Annuity

Phase V : 6-laning of 6,500 km on DBFO basis | 412.10 10.05

278.00 6.78

Phase VI : 1,000 km Expressways on DBFO

i 166.80 4.07
basis
Phase VII1 : Ring Roads, Bypasses etc. on
BOT - Toll/Annuity 166.80 4.07

Total | 2354.30 57.42
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D I A

Kanniakumari

Legend

Golden Quadrilateral 5,846 km

North-South Corridor 3,756 km

=
et

East-West Corridor | | 3445 km
| 12,109 km

NHDP Phase - III

BAY OF BENGAL

NOT TO SCALE

0 Cc E. . A N
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NATIONAL HIGHWAYS DEVELOPMENT PROJECT I‘“"I"‘H"‘D"I'j

PHASE - V & VI NOUE
|

JAMMU AND KASHMIR

® Srinagar Legend Eg .

NHDP Phase -V | IS | 6500.00
NHDP Phase - VI | I | 1787.00

Porbandar

BAY OF BENGAL

‘Kanniakumari

| N D 1 A N o} C E A N

The cateraal bowadarion snd comtlines of India agree with the Hecond Master Copy coriified by Servey of Tasbis and spproved for NHAT vide their latter ma. #1207 702 A4 ror0orsd - XXX Dwiedd 13702003
Frwsared Bv: Infarmation Teckaatory & Masates Diviie. 1L
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* Four lane Dual Carriageway facility

“* Improved geometrics and intersection layout

% Segregation of slow/ local traffic by service roads
* Grade separators at major intersections

“ Subways for pedestrians/ local traffic

** Road over Bridges at Railway crossings

** Bus bays and truck laybys
< Improved traffic signs and markings =3

f .
' . -
e S

. o | ANEMA R
s Safe practices In construction zones | o — .. T ;

% Safety Barriers at hazardous locations |

“ Proper maintenance of facilities
“* Emergency Medical Services
“ ITS application

skl
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i New Initiatives
“*National Road Safety Board
=>Expert Divisions in

* Road Engineering and Safety

= Automobile Safety

= Data Analysis and Research

= Communication and Human Resource
Management

= Traffic Engineering and Enforcement
= Emergency Medical Help
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* Structure
» Chairman

» Members with Expertise in

Road and Traffic Engineering
Automobile Engineering

Traffic Laws, Enforcement, Education
Database and Analysis

Medical care, Training
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National Road Safety Board
(Contd.)

“* Functions
» Commission and Conduct Road Safety Audit
» Setting of Safety Standards for roads
» Recommend Traffic Calming and similar safety features
» Set Standards for Safety features for vehicles
» Audit for adherence to Standards

» ldentify Research Areas in Safety and Establish Excellence
Centers

» Maintain the Data Base
» Promote Best Practices in Road Safety

» Identify/recognize and assist NGOs in the area of road
Safety

» Lay down guidelines for trauma care
» Advise Central Government on Issues of Road Safety

» Liaise with International Agencies in Road Safety
29 23e Congres mondial de la Route -




< Powers
» Spot Checking through Auditors.

> Issue direction for Corrective measures in cases of
non-adherence to Standards

» Power to penalise for non- adherence

“ Budget
» Grant from Dedicated Road Safety Fund

» Created from 1% of Cess from sale of Petrol and
Diesel —around $ 30 million per year

* Road Safety Board at State Level
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Emphasis on Road Safety in the development during next 5 years

Pedestrians and cyclists safety

» Speed limit of 50 kmph on arterials and 30 kmph on residential road —
potential of saving around 5000 lives per year

Motor Cyclist Safety

» Compulsory helmet law by every State and day time headlight use —
potential of saving around 3000 lives per year

Motor Vehicle Occupant Safety

» Enforcement of seat belt use

» Speed governors

» Potential of saving around 4000 lives per year
Vehicle Safety

» All vehicle to meet international crashworthiness standards by 2010
Safer Design of highways

Trauma care facilities specially along highway
23e Congres mondial de la Route - Paris 2007




Policy Initiatives for Safer Design

* Manuals for developing and designing of 4/6 lane highway
» Partial control on access
» Separation of local/slow traffic through service roads
» Entry to and Exit from service road through ramps

» No at-grade intersections for 6 lanes highways and limited
at-grade intersections for 4 lane highways

» Detailed system for signs and markings

» Control and access from private properties

» Facilities for pedestrians and cyclists

» Facilities for crossing of cattle

» Controlled opening for medians

» Provision of Rest Areas and bus bays

» Application of Intelligent Transport Systems (ITS)
» Provision of Ambulances/cranes and patrolling

» Safety Audit in Design and Pre-Opening
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Entry Ramp for Service Road

—— 1.5m Wide Seperator
rW.Sm Wide Paved Footpath

L ORI
——
—_—
—— ——
O
— R — -
- - - -

Deceleration lane

Note -
1. Detailed system of Road Markings as per IRC:35
2 Detailed system of Road Signs as per IRC:67

—— Median Varying width
—— 11.0m Wide Carriageway
15m Wide Paved Shoulder
2.0m Wide Earthen Shoulder

MINISTRY OF SHIPPING, ROAD TRANSPORT & HIGHWAYS
DEPARTMENT OF ROAD TRANSPORT & HIGHWAYS

IYRAWING TIT Ll

Suggestive Layout for Exit Ramp from Highway

Figure: 2.1C

SCALE:- Notto Scale
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Exit Ramp from Service Road

15m Wide Seperator

1.5m Wide Paved Footpath

—— Median Varying width
L——— 11.0m Wide Carriageway

1.5m Wide Paved Shoulder

2.0m wide Earthen Shoulder

Note:-
4 Detailed system cf Road Markings as per IRC:35
2. Detailed system cf Road Signs as per IRC:67

Acceleration lane

MINISTRY OF SHIPPING, RCAD TRANSPORT & HIGHWAYS
DEPARTMENT OF ROAD TRANSPORT & HIGHWAYS

LIRAWING TI Ll

Suggestive Layout for Entry Ramp to Highway

Figure: 2.1D

SCALE:- Notto Scale
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Side Road

Service Road —_-—

~_Medion

Mational

National Highway

National Highwa:
Median :

Mational Highwa
Median ~

Mational Highway National Highway

Side Rood

- Service Road

Natienal Hi

Matienal Highway

1
2

Note:-

Detailed system of Road Markings as per IRC:35
Detailed system of Road Signs as per IRC.67

[
4— Spacing te depend —‘»

Under Pass

MINISTRY OF SHIPPING, ROAD TRANSPORT & HIGHWAYS
DEPARTMENT OF ROAD TRANSPORT & HIGHWAYS

DRAWING TV LL:-
Suggestive Layout showing configuration of service
road, entry/exit ramps, side road and underpass

Figure: 2.3

SCALE:- Notio Scale
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Highway Traffic Patrol In some States
e.g. Haryana, Kerala

Post Accident Management — Tamil Nadu

Safety Aid Posts and Safety Task Force in
Maharashtra

Support for NGO’s on Awareness generation
and sensitization of community including
villagers
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“ Safety Audit on about 50% of completed Golden
Quadrilateral sections

New Initiatives (Contd.)

+» Low cost counter measures at hazardous locations
* Safety Provisions in Construction Zones

“*Training of Trainers for dissemination of road
safety manual

** Introduction of Intelligent Transport Systems (ITS)
» Advanced Traffic Management Systems (ATMS)
» Electronic Toll Collection (ETC)
» Advanced Traveller Information Systems (ATIS)

23e Congres mondial de la Route -
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New Initiatives (Contd.)

Crash Lab

Digital Movie/ Still Camera

High Spot Light synchronized with camera

Laser device for distance/ speed measurement
Software for data processing to reconstruct collisions

Software for simulation and analysis
Violations recorded dealt by the police and engineering

shortcomings are conveyed to the Traffic Engineering Cell.
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Increase in Driver’s Training School

Refresher Courses

Traffic Parks

Schools encouraged for imparting safety education
Safety Week observance

Assistance to NGOQO’s-Training, Booklets, Awareness
Campaign among local people

Training by National Institute for Training of Highway
Engineers and Central Road Research Institute

Use of Mass Media
Seminars / Workshops

23e Congres mondial de la Route - Paris 2007
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Documents on Road Safety

Manual for Safety in Road Design

Geometric Design Standards for Highways
Highway Safety Code

Guidelines for Safety in Construction Zones
Standard Drawings for At-grade Intersections
Code of Practice for Road Signs

Code of Practice for Road Markings
Technical Circulars from Ministry

Safety related Guidelines by Indian RoadsI
Ccongress I
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* Black spot Identification System

*» Safety Audit
* Traffic Calming Technique
* Policy for Hoarding on Highways

»» Road Safety Policy (to be endorsed by Prime
Minister) and Action Plan

* Road Accident Costing
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Enforcement Measures

Operation and Maintenance Contract R
.

Highway Patrolling
Modern Tools
» Interceptor Vans
» Breathalysers
Motor Vehicles Act Amended
» Speed and Weight limits
> Carrying of the Hazardous material
» Enhanced Penalty for Traffic Rules Violations
Seat belt in car/ Helmet for 2-wheelers
Driver Licensing system computerized
Vehicle Registration and fitness system stricter
Speed Governors for Public Transport Buses
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Infrastructure Improvement
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Flyover and Service Road
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Chevron Signs at Curve
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04/05/2005
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l Rest Area On Ahemdabad — Vadodara
Expressway
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** Advanced Traffic Management Systems
(ATMS)

» 180 km stretch of National Highway
»  Mumbal — Pune Expressway

» Area Traffic Control in Delhi
»  Covering 47 intersections
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ATMS on National Highways

4

% 180 km section of National Highway 8
Emergency Call Boxes (ECBSs)
Variable Message Signs (VMS)

CCTV System

Mobile Radio Network

Fibre Optic Communication System
Automatic Traffic Counter and Classifier
Meteorological System

Highway Patrolling

Ambulance Services

Tow away Cranes
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=  Emergency call box for ATMS
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Emergency call box for ATMS

B
o s
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Components for ATMS

HTRS

R T T O
RO B CICRELE
BOCTOENT HHERC

(e SLOLY
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Control Room on NH-8
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ATMS Control Room
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